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Welcome!

Welcome to the Winter 1999/2000 edition of the Decision

Explorer Newsletter. Over the past few months we have

been out and about and have got to meet a few more of you

at various conferences and events around the UK and in

Boston (Mass, USA rather than Lincolnshire, UK - as

someone commented to me last week). It is really nice to be

able to meet our customers and to be able to put a face to

people, some of whom we have known for years by phone

and email and who have been using Decision Explorer since

its “DOS days” as COPE. We will continue to advertise

events on our web pages, including details of any

conference where we will have representation. So, if you

happen to be at one of the conferences that we attend, please

come up and say “Hi!”.

In this and the next edition of the Newsletter we will,

amongst other things, be providing details of how cluster

analysis is used in Decision Explorer and how to use

password protection on shared models. We have already

covered file types (*.mdl, *.mdk and *.mlk, in the “sharing

models” article in Issue 2 of the Newsletter) and will

continue in future issues to feature articles which deal with

the questions about the functioning of Decision Explorer

that crop up most often. Previous editions of the Newsletter

can be downloaded from our web site at www.banxia.com,

so if you have missed an article that you think might be of

interest or help to you, the information is still available.

Please remember that we are always interested in hearing

from you, so if you have any comments or contributions

which you would like to make, please call us.

Jenny Brightman, Banxia Software Ltd

News

Decision Explorer Student Edition -
now available!

In Autumn 1999 we launched a new, lower priced

edition of Decision Explorer 3.1. The Decision Explorer

Student Edition is aimed at individual users who are

studying for an academic qualification and who want

their own copy of Decision Explorer on their PC, for

use at home. The Student Edition cannot be run over a

network (in the way that the full academic edition can

be) and is, as we say, intended for personal use. A full

description and comparison of the capabilities of the

various editions of Decision Explorer can be found at

http://www.banxia.com/dexplore/editions.html.

Reseller network

We are pleased to announce the continued expansion of

our reseller network. Beyond the UK Banxia either now

has, or is currently negotiating with, additional resellers

in Australia, The Netherlands, Israel, South Africa,

Taiwan and the USA. Some of these resellers deal only

with one of our products (Decision Explorer or Frontier

Analyst) while others deal in both products. Our web

pages carry address and contact details for our resellers

and outline the services which they provide. Please visit

http://www.banxia.com/reseller/index.html for details.

Talking telephone numbers

Over the next few months you will start to see new

telephone and fax numbers appearing on our web pages,

in our product literature and on other supporting

materials. We are now using “0870” numbers, which

will allow us to expand more easily in future. The new

telephone number in the UK is 0870 787 2994 and the

new fax number is 0870 787 2995. As UK residents will

be aware the telephone “Big Number” change is

happening in the UK between January and April 2000.

During this time many telephone codes in the UK will

change. Our new numbers are operational now and will

be unaffected by the “Big Number” changes.
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Cluster analysis - how it works

The cluster command in Decision Explorer gives you a form of analysis based on the structure of your model. It takes no

account of the contents of the concepts’ text or their meaning: the analysis is based solely on the structure of the links between

concepts. All links are considered as having an equal weight (that is there is no sense of any particular type of link being

“stronger” than another). The clusters that are identified are mutually exclusive i.e. concepts can appear in only one cluster at a

time.

A typical use of cluster analysis is to split a large model up into related sections. With no “seeds” (explained later) the effect of

the analysis is to produce a numbers of sets, which are relatively isolated clusters of ideas. You may then want to explore the

“bridges” between and “islands” of clusters. Going through a cycle of model elaboration and clustering can be very helpful

when constructing a model. By mapping the clusters you can quickly get insight into “missing links”, for example, when you

have two clusters which are talking about the same kind of issues. The idea behind the cluster analysis is that the meaning of a

concept is related to the concepts that it is linked to, so the groups of concepts that are identified will relate to roughly the same

area of the discussion.

In this example, concepts [50] and [54] have similar explanations and consequences (i.e. they are linked to the same concepts).

Therefore they are likely to form part of a single topic. Intuitively even a large model can be broken up into a series of topics in

this way, although for complex models the identification of the centres and boundaries of each topic is necessarily an art rather

than a science.

In Decision Explorer the cluster analysis should provide you with a “suggestion” of

independent topic areas. The word “suggestion” is used for two reasons. Firstly,

because you are likely to map the clusters, then edit and change links, add

explanatory and consequential concepts. And secondly, because cognitive maps are

rarely “comprehensive” and “normalised”: for example, in a single map some

concepts will cover small details, while others cover complete policy areas. The

underlying mathematical methods used in cluster analysis rely on the

“comprehensiveness” and “normality” of the initial data and cognitive maps rarely

satisfy these criteria.

For concepts [50] and [54] the Jaccard

Coefficient is simply:

This ignores concepts that are not linked to either concept [50] or [54] (the number of indirect links is usually large in relation

to the number of direct links). We can generate a matching score for any pair of concepts in the model. The clusters are built up

using a simple, single link hierarchical clustering method. We begin by picking up a concept, we then pick up another concept

and compute the matching score between the two concepts. If the matching score is greater than a pre-set threshold value the

concepts are placed in the same cluster (set), otherwise the second concept forms the seed for a new set. Another new concept

is then picked up and a matching score computed for this concept and the seed concept of each existing cluster set. The process

continues until all of the concepts in the model have been analysed and their matching scores calculated. If a seed set is

specified at the start of the cluster analysis, the concepts in the seed set are used as the initial cluster sets, thus providing

“prompts” for the analysis process.

For cognitive maps this clustering process usually produces a lot of small clusters. The

cluster command also amalgamates small sets into larger ones by merging groups towards

“head” concepts until the target set size is reached. The sets are then inspected again and

floating heads and tails are merged into the nearest group. The target size obviously has a

large influence on the final number of clusters. The default target size setting is 30 concepts

per cluster, but this can be changed by the user in the range 5 to 90.

Certain assumptions have obviously been made in the clustering algorithm which has been

developed for Decision Explorer, for example, the inclusion of floating head and tails is

one which resulted from experience in using the tool. Experience has shown that in “real life use”, more sophisticated methods

of clustering are inappropriate when dealing with cognitive maps.

Generally speaking, the clustering method is useful in large models which cannot be split visually into areas of related issues,

and it will reveal clear cut groups (clusters) of concepts, if such groups exist. Where concepts in a map are very heavily

interconnected the value of clustering is much more questionable. You can “force” clusters by reducing the target size to a

minimum value of 5 concepts per cluster. However, if the “forcing” process still reveals relatively large clusters, then this is an

indication that the model is heavily interlinked and cannot be broken down further.

It is important to remember that cluster analysis gives you a hypothesis about the model structure and should be treated as such,

but it can be very useful in directing you to “natural” topics within the data, if they exist.

50 51 52 53 54

50 0 1 1 0 0

54 0 1 1 1 0

Number of concepts directly linked to pair = 2 = 0.67

Total number of concepts linked to pair 3

In Decision Explorer “Jaccard Coefficients” are used to identify clusters. For cluster analysis

we require a “matching” score for each concept in relation to the others in the surrounding

map. For the small map shown here, with only 5 concepts, the table of “matches” would look

like this:
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Decision Explorer 3.1

We promised in the last newsletter that we would provide you with more details of the new features in Decision Explorer 3.1.

This development was classed as a minor upgrade, so free upgrades are available from our FTP site to anyone who is a

licensed user of Decision Explorer 3.0.4 or later (CD-ROMS are available but a charge will be made for the CD, shipping and

handling). The main feature of this upgrade is one that you may not even notice! Decision Explorer has moved from 16-bit to

32-bit operation. The reason for this move is to keep the software up to date and to provide a platform for future developments.

Of course this means that you can now use long file names (more than 8 characters) and you can have spaces and punctuation

characters in your file names. Decision Explorer 3.1 runs on Windows 95, 98, 2000, NT4 or later. A 16-bit version (Decision

Explorer 3.0.8) is still included on the install CD for Windows 3.1 support.

One of the new features (which I find most useful!) is “rapid entry” mode. There are various ways in which you can access this

mode, the first is through the Edit Menu, Rapid Entry mode item. When you click on this menu item a “check” will appear next

to it, showing that you are now in rapid entry mode. If you click on this menu item again the check will disappear and you are

back in “normal” entry mode. You can also access rapid entry mode through the tool bars (using the button. Or, when you

have typed a concept on the command line, pressb +f, when you finish the concept.

If you are using the Edit menu, select this option and enter your next concept. Press enter and you will be prompted for another

concept, either by an “equals sign” (=) on the command line or a cursor prompt on the mapping area, depending on how you

chose to enter the first concept. When you are in rapid entry mode, you can just type, press enter, type, press enter, type press

enter and so on - to enter a succession of concepts. To come out of this mode either select the rapid entry option again from the

Edit menu, pressˆ or pressb +f when you enter your last concept.

Other features include the “launch link” feature in the memo cards, full screen mode and additional zoom control. To use the

launch link facility in the memo cards you simply enter the path name for the destination document in the memo card. If the

body of the memo contains text in the form “location:name” (i.e. a colon with text either side, such as c:\report10.doc or

http://www.banxia.com), then you can "launch" the destination application and document from the memo pop-up menu (which

is accessed via the right mouse button. Place the mouse pointer over the concept to which the memo is attached and right

click). Typical uses of this feature would be to launch web pages (using text such as: "Source was the web page

http://www.banxia.com") or to take the user to a more detailed document (using text such as: "Full document is stored in the

file c:\docs\source.doc where you will find the full text on pages 9-12.")

With full screen mode you have the ability to maximise the screen display area to the fullest possible extent. You can turn off

both your tool bars and the view tabs (if you wish), then type the command “Full” or use the Window menu, Full item. You

can still add, edit and move concepts in the usual way. To switch between views usea+<view number> e.g.a+1 to get

to view one,a+2 to get to view two and so on. Usinga+j+<view number> adds 10 to the view number and

a+badds 20 to the view number. In full screen mode you can use the command line in the usual way and access the other

menus using their shortcuts e.g.a+F for the file menu and so on. To get out of full screen mode, type the command “Full”

again and the mode will change back to normal operation. When might you want to use this mode? Full screen mode was

introduced in response to a request from a consultant who wanted an uncluttered display, with maximum legibility, for use at

the start of group sessions. Another use would be during the course of a workshop, when you want to pause, focus discussion

and concentrate on a particular group of concepts.

Also a custom scaling option has been introduced, primarily to help with live use of Decision Explorer. Thea+[ and a+]

key combinations allow you to change the map view display scale by a predetermined amount (5% increase or decrease in

size). The minimum display scale is 10% while the maximum is 200%.

From the bookshelf

Named the "Best Book of 1995" by the Public and Nonprofit Division of the North American Academy of Management, we

would like to commend to you John Bryson’s book “Strategic Planning for Public and Nonprofit Organizations” (Revised

Edition, published by Jossey-Bass, San Francisco, CA. 1995). Until now this book was missing from our bibliography on

cognitive mapping, decision support, strategy formulation, and applications of Decision Explorer (which can be found at

http://www.banxia.com/dexplore/debiblio.html).

The original edition of this book was reprinted 9 times and became “the standard book” in the field. As well as giving an

introduction to the dynamics of strategic planning the book deals with what are seen as the key steps in using the strategy

change cycle to think and act strategically, and getting started with and managing the process of strategic planning. The

resources section also contains a section devoted to oval mapping, which is a paper based form of the cognitive mapping

technique supported by Decision Explorer.

In praise of this book, Beverly Stein, chair of the Multnomah County Board of Commissioners, Portland, Oregon, comments

that: “When I am asked for advice on strategic planning for government or nonprofits, the very first resource I recommend is

John Bryson’s book. It is a must-have tool for anyone working toward the common good.”

If you are interested in more information about this book, please visit http://www.josseybass.com/, click through to the

“Nonprofit organizations” section and use the search facility at the foot of the page.
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Events and training courses

If you would like more information about any of the events listed below, please contact either ourselves (Banxia Software Ltd)

or the appropriate event organiser. If you are not sure who is the right person to contact, then please just call us or email to

training@banxia.com, we will be able to help you!

Thursday 24th February. London, UK.

Academics "Come & See” day.

A free event for an audience of lecturers, research students

and researchers. Three short sessions, repeated throughout

the day, where you are invited to come and talk about and try

out Decision Explorer.

Friday 25th February. London, UK.

Commercial users "Come & See" day.

A free event for an invited audience of managers and

management consultants. Three short sessions repeated

throughout the day, where practitioners are invited to come

and talk about and try out Decision Explorer.

Monday 28th February 2000. London. UK.

An Introduction to Decision Explorer.

One-day, hands-on workshop run by SdG Associates, taking

you through the theory and practice of cognitive/ ideas

mapping and the use of Decision Explorer.

Mid to Late March 2000. (Date to be confirmed).

Boston, MA, USA.

An Introduction to Decision Explorer.

One-day, hands-on workshop run by SdG Associates, taking

you through the theory and practice of cognitive/ ideas

mapping and the use of Decision Explorer.

Thursday 18th May. London, UK.

Academics "Come & See” day.

A free event for an audience of lecturers, research students

and researchers. Three short sessions, repeated throughout

the day, where you are invited to come and talk about and try

out Decision Explorer.

Friday 19th May. London, UK.

Commercial users "Come & See" day.

A free event for an invited audience of managers and

management consultants. Three short sessions repeated

throughout the day, where practitioners are invited to come and

talk about and try out Decision Explorer.

Monday 5th June 2000. London, UK.

An Introduction to Decision Explorer.

One-day, hands-on workshop run by SdG Associates, taking

you through the theory and practice of cognitive/ ideas mapping

and the use of Decision Explorer.

5th - 9th June. University of Minnesota, MI, USA.

An Introduction to Systems Thinking Tools for Public and

Nonprofit Organizations.

In this course, run by Prof. John M. Bryson of University of

Minnesota, you will (amongst other things) learn about

cognitive mapping, oval mapping, Decision Explorer, and

system dynamics modelling in the context of managing

strategic change. The course will meet all day Monday 5th,

Tuesday 6th and Wednesday 7th June, the evening of Thursday

8th and all morning Friday 9th. Please contact Prof. John M.

Bryson, University of Minnesota, jmbryson@hhh.umn.edu for

costs and further information (course reference PA 5990).

Monday 26th June 2000. London, UK.

Advanced Decision Explorer Workshop.

One-day workshop, tutored by Dr. Fran Ackermann,

concentrating less on the mechanics of using Decision Explorer

and more on the wider picture of how you would use Decision

Explorer and cognitive mapping in a workshop setting, as part

of a decision support intervention with a client group.

Training contacts

Jenny Brightman. Banxia Software Ltd, 141 St James Rd, Glasgow.

G4 0LT. Tel: +44 (0) 870 787 2994. Fax: +44 (0) 870 787 2995

Email: jennyb@banxia.com.

Silvana di Gregorio. SdG Associates, 20 Alconbury Rd, London,

E5 8RH. Tel/Fax: +44 (0) 20 8806 1001

Email:de@sdgassociates.demon.co.uk.

Prof. John M. Bryson, Hubert H. Humphrey Institute of Public

Affairs, University of Minnesota, 245 Humphrey Center, Minneapolis,

MN 55455, U.S.A. Tel: +1 612 625 5888

Email: jmbryson@hhh.umn.edu.

Feedback

We very much welcome comments from readers, suggestions about

articles that you would like to see in this newsletter and any articles

that you would like to submit for publication.

If you have any suggestions or would like to contribute an article then

please contact Jenny Brightman, at Banxia Software Ltd, by telephone

on +44 (0) 870 787 2994 or by email to news@banxia.com. Thank

you.

Impact Explorer

We are pleased to announce “Impact Explorer”.

This new piece of software is aimed at risk

assessment, for use by groups in a facilitated

workshop setting. Impact Explorer allows you

to vote on ideas in various ways and to display

impact/ probability matrices. As you may know,

Decision Explorer has DDE capabilities which

means that it can interact and exchange

information with other software applications

(some Decision Explorer users are already

making use of this facility). You can, if you

wish, make use of these capabilities and

exchange information between Impact Explorer

and Decision Explorer. Otherwise, you can use

Impact Explorer as a stand-alone “voting” tool.

To use Impact Explorer you need a radio

key-pad voting system (manufactured by the

Fleetwood Group, www.fleetwoodgroup.com).

This system and the Impact Explorer software

allow you to work with up to 250 users. Full

release of Impact Explorer is expected in March

2000. Outline details can be found on our web

pages at www.banxia.com/impact/index.html.
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